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INSTALLATION

You can access RefWorks through the University of Notre Dame Library website. Click on RefWorks underneath the
Researching Help menu on the first page.

Research Support
Search Tools Library Services Researching Help

eResources Borrowing | My Library Account Liaison Librarians
Citation Search Renew an Item Subject Guides
eJournal-eBook Title Search Reciprocal Borrowing EndNote [ RefWorks >
Catalogue | Trove Assignment Cover Sheets Referencing Guide
Reserve Search Contact Us ResearchOnline
Google Scholar Recommend a Resource

Access RefWorks by clicking on the blue RefWorks Login link on the following page. If you haven’t yet created a
RefWorks login, do so by selecting Sign Up for a New Account, otherwise, just log in with your RefWorks Account.

RefWorks New to ReﬂNorksr—\
Sign Up for a New Account

RefWorks is a web based research management, writing and collaboration tool" Login using RefWorks Credentials

and citations and to share these with colleagues. You can add citations while yc Login Name

style you choose, adding both in-text references and a bibliography. | |

Password

« RefWorks Guide

¢+ RefWorks Login - ) Keep my session open

U Logi
for 14 days st

This will bring up your RefWorks Profile.

Navigate to the Tools tab and when it drops down, select Write-N-Cite.

@® RefWorks

Search Your Database

&Nlta Additional Information

|_g New Folder E Create Bibliography () New Re

RefGrab-It

I'-af;?Backup & Restore
References > All References

References ][ Organize & Share Folders 1
References to Use ) - Sort by Change View
(e)Selected © ( )Page | ( )Allin List fo » |©|X & Authors, Primary % Standard View =
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Before you download Write-N-Cite, take note of which version of the Mac OS you have. You can find this out by selecting
the Apple symbol, and then selecting About This Mac.

Take note of the Version Number, as that determines which version of
Write-N-Cite you want to download.

LR R Al ]

For most, it should be the most recent version on the RefWorks

Software Update... website.

App Store...

Downloads

About This Mac

Q & Write-N-Cite 4 for Word (Mac) 21.3 Mb
Version: 4.4.1237 (2014-11-04) @)
a For OS X 10.6 (Snow Leopard), 10.7 (Lion) and 10.8
(Mountain Lion)
Supports Word 2008 and Word 2011

Having trouble installing Write-N-Cite 4? Our installation guide might
help, or you may need to check the Mac or Windows software
requirements.

Os X

Version 10.9.5

| Software Update... |

Download and install the file as you usually would.
NOTE ABOUT MAC OS YOSEMITE (10.10):

If you are having issues with installing RefWorks on your Mac and the installer directs you to install a version of Java
through Oracle, disregard that link. Install Java from this link instead: http://support.apple.com/kb/DL1572

IN WORD

Insert it Font Tools Table Window % Help
Draft RefworksReferencesTe

Web Layout SEL# o] © When you first open Word, it will most likely look like it didn’t
sttty s e download properly. Unlike the PC version, Write-N-Cite is a floating
o A e . toolbar instead of an additional tab.

Publishing Layout 2= |00~

o AaBbCDAE

Focus o; «||A 24 . ) ’
P o If the floating toolbar doesn’t appear after you’ve completed the
| Toolbars > [RCLELL installation, restart Word. If it's still missing, navigate to the View tab
Sidebar > Formatting . . . .
Message Bar e and under the Toolbars option, tick Write-N-Cite.
atabase
Media B ~¥EM EndN X7 . . . , .
e o The Write-N-Cite toolbar isn’t labelled, but you can find out what
Toolbox . . . .
© Styles Customize Toolbars and Menus... each icon does by hovering over it with your mouse.

VUG, i GV U 1S LUITPISHS YUuIus W 1 SJGr I

‘ Citations

To make things a bit easier, we’ve labelled them for you:

Insert Citation Edit citation

Il |

Apply current output style
Logiy Logout

Preferences
Insert/Remove bibliography x

¥
r |-| -

apa6th - amd=| & [ [3

0T

Insert a recent citation

Format bibliography f

Remove field codes

Sync data
Styles
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CREATING FOLDERS

You may want to create separate folders in RefWorks for each class or assignment to help keep your references
organised. To do this, click on the New Folder button.

Give your folder a meaningful name, then click Create.

Create New Folder
.| Lo New Folder E‘ Create Bibliography @ | New Folder Name (Create Subfolder);

References = All References

References | Organize & $ ( | g Create ) !ancel

References to Use » b
® Selected | Page i alinLiet § |-@ ¥ '@ | Authors, Primary * | | Standard View v
Folders =
r My List Your new folder will appear in the folders list on the right of the screen. Click on your newly
Mot In Folder  (7) created folder to open it.
5@ Lastimpored (1)
» Documents (0)
Examples (B)
Maedaleria Fowleri {0}
ADD A REFERENCE MANUALLY
To manually add a reference, click on the New Reference button or select References — Add New:
] References | This brings up a pop up for you to enter in the citation information.
/—-\ Choose APA 6th (recommended) to see the fields required specifically used
mpon —der . [ create Bibliography | (&) New Reference by that format
UExpnrt .

-5 = All References

Be sure to select the type of reference you're entering

by selecting the Reference Type dropdown.

Fields used by [APA 6th - American Psychological Association, 6th Edition ¥ @ About this style
- Enter AUTHORS with last name first, and separate and Reference Type | Joumal Article v
each author W|th asem |C0|On . For exam ple The following fields are used by your selected output style. You can access additional fields below.

Authors:

Smith, Jane; Thomas, Karl;

OR

Title: g 7 U x x

Smith, J.; Thomas, K.;

- Do not place any punctuation at the end of the Perodical, Ful
TLE e
- If you have a DOI you must include it in your lssue:
reference as this is part of APA 6, and it helps m:”:g“
RefWorks to link to your article. o

Original/Translated Title: B I U X x*

- Scroll down, and you can select the folder where
you’d like your reference to be saved.

[=] save Reference (&) Save & Add New
Add to folder Selectafolder... N ' #
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You will also have the option to add a URL to the Links field for the location of your resource is it was available freely
over the internet (not required for anything on the Library databases), or you can upload a PDF or other electronic copy of
the article by clicking Browse and adding Attachments if it is not accessible on the web. Make sure you save your
reference before you click Browse as this will wipe all the information you have entered.

RefWorks will allow you to store up to 1GB of

. . . . . . Add New Reference X
uploaded files, with the maximum file size being @ten .
20MB Fields used by | APA6th- A Psychological Association, 6th Editon =] @ About this siyle 1
and Reference Type | Jounal Article [=]
When you’re ﬁniSheda CIiCk On Save Reference; Or The following fields are used by your selected output style. You can access additional fields below.
If yOU haVe more references to add, CliCk Save & E Authors: Roy. S L; Matzger, R Chen, J. G: Laham, F. R ; Martin, M.; Kipper, S. W ; Smith, LE ; Lyor
Add New. MED 2 U % x|
. Risk for transmission of naegleria fowleri |
Your newly created reference will be added to the from solid organ transplantation| ]
selected folder if you chose one, otherwise it will
be added to the ||St of references under Not |n Periodical, Full: American Journal of Transplantation
Pub Year: 2014
FOlder Volume: 14
Issue: 1

Start Page: 163 -
Other Pages: 171
DOE: 10.1111/ajt 12536

OriginalTranslated Title: B I U x, x:‘

(' [=) save Reference ™ (@ Save & Add New

P

ORGANISING YOUR REFERENCES

If you’ve found quite a few references but forgot to add them to your chosen folder, you can move them by ticking the box
next to your reference (thus enabling you to move more than one at once), then hovering over the folder icon and
selecting your desired folder.

References I Organize & Share Folders
Rafarences to Use h Sort by Change View
)
®) Selected Page | Allin List £ =0 | B|X|S Authors, Primary ¥ Standard View v
| Mew Folder
i RefID 17 —o W s X (& |
7 My List
Authors  Adit Sachan Avesh; Chi —
Title Dermatillomania: In patiy  + Desuments (0]
Source Indian Journal of Dental S . Publications and Media Pvt. Ltd,
efworksReferencesTest (3)
Mangalore
Folders Examples: Examples (8)
Check for
Full Text
s RefID 11 AR q ¢
Authors Alexeieff A
Title Maegleria fowleri
Source Emerging Infectious Diseases, 2011, 17, 2, 261, U.5. National Center for Infectious Diseases
Check for
Fuill Text
You know you’ve successfully moved your references when you see a green @ Completed
Confirmation notification. 3 item(s) moved to Naegleria

Fowleri.
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ADDING A REFERENCE USING DATABASES

Adding a reference to RefWorks using a database is called exporting/importing. Each database will export references in a
slightly different way, so check the help menus for the database if you are unfamiliar with its specific process.

EBsco DATABASES

SINGLE CITATIONS
Click into the record you want to export by clicking on its title.

On the right side of the record, there’s a tools menu. Within that menu, select Export.

This brings up the Export Manager.

« Result List = Refine Search 4 4 of 574 »

= Export Manager E-mail

Number of items to be saved: 1

Save citations to a file formatted for:
Direct Export in RIS Format (e.g. CITAVI, EasyBib, EndNote, ProCite, Reference Manager, Zotero)
Generic bibliographic management software
Citations in XML format
Citations in BibTeX format
Citations in MARC21 format
) Direct Export to RefWorks
Direct Export to EndNote Web
Direct Export to EasyBib

Save Cancel

Select Direct Export to RefWorks, then click Save. You may be asked
to log back into RefWorks, and then an import notification will appear.

Your newly imported reference should now appear in your View Last
Imported Folder. To move it to your desired folder, just follow the
instructions above, under the heading Organising your References.

MULTIPLE CITATIONS

To export multiple citations from Ebsco databases, the process is
similar. As you find articles that are useful, rather than exporting each
individually, add them to your EbscoHost folder by clicking on the Add
to Folder icon.

Tools »

Add to folder

a Print

€l E-mail
s

H Save

Cite
(| Export ‘

©" Create Note

e Permalink
Import References X
Import Log
Duplicate Checking Options
L) View Duplicates View Last Imported Folder

The Add to Folder icon can be found on the main search results screen, as well as under the tool menu in each individual

record.
Tools »
¢ Add to folder >
Search Resulis: 1-2 of 2 Relevance v Page Optionsv  Share v & Print
1. Tap water or "sterile” water for sinus irrigations: what are our patients IS, - Bl
using? =
(English) ; Absiract available. By: Sowerby LJ; Wright ED, International Forum OFf Allergy & Rhinology [Int S
Forum Allergy Rhinol], ISSN: 2042-6984, 2012 Jul-Aug; Vol. 2 (4), pp. 300-2; Publisher: Published for H e
ARS-AAOA by Wiley-Blackwell, PMID: 22411733
Academic Subjects: Amebiasis prevention & control, Central Mervous System Protozoal Infections prevention & Cite
Journal control; Naegleria fowleri physiology; Rhinitis therapy; Sinusitis therapy; Therapeutic Irrigation adverse
effects; Therapeutic Irrigation methods
; = Export
,D Linked Full Text

Using RefWorks — For Macs
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Once you’d added all useful articles to your folder, click on the Folder icon.

E\ Folder , Preferences  Languages - Need Help? - AskUs  Help

Select the citations you wish to export by ticking the individual box next to each, or by ticking Select All to select all of
them, before selecting Export on the toolbar to the right.

Articles Print
rin
1-40f4 .
- Name~  Page Options v f};«: E-mail
o Select/ deselect all H Save as File
« 1. Biocidal efficacy of monochloramine against planktonic and biofilm-associated Naegleria  © (‘ = gm\
fowleri cells. i

(English) ; Abstract available. By: Goudot S; Herbelin P; Mathieu L; Soreau S; Banas S; Jorand FP, Journal Of Applied
Microbiology [J App! Microbiol], ISSN: 1365-2672, 2014 Apr; Vol. 116 (4), pp. 1055-65; Publisher: Published for the Society for
{ Applied Bacteriology by Blackwell Science; PMID: 24387688, Database: MEDLINE

Academic Subjects: Biofilms drug effects; Chloramines pharmacology; Disinfectants pharmacology; Naegleria fowleri drug effects;
Journal Plankton drug effects

Linked Full Text

« 2. Genome-wide identification of pathogenicity factors of the free-living amoeba Naegleria jo)
fowleri.

(English) ; Abstract available. By: Zysset-Burri DC; Miiller N; Beuret C; Heller M; Schirch N; Gottstein B; Wittwer M, BMC
Genomics [BMC Genomics], ISSN: 1471-2164, 2014 Jun 19; Vol. 15, pp. 496; Publisher: BioMed Central; PMID: 24950717,
{ Database: MEDLINE

Academic Subjects: Naegleria fowleri genetics
Journal

ﬁ PDF Full Text

The following steps are the same as exporting a single citation. Select Direct Export to RefWorks and click Save.

Using RefWorks — For Macs Page | 6
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PUBMED (OR ANY OTHER DATABASES THAT DON’T SUPPORT REFWORKS)
Citations can be exported from databases which do not support RefWorks, but which do support other referencing
software. This example will be for PubMed, but other databases should have similar options.

In PubMed, click into the record you wish to import. In the corner of that record, there is a little drop-down menu called
Send To. Expand the dropdown, select Citation Manager, and then Create File.

Abstract ~ ¢ Sendto:v %
) Choose Destination
Acta Trop, 2015 Feb;142:86-8. doi: 10.1016/j.actatropica.2014.11.004. Epub 2014 Nov 13. File Clipboard
Tackling infection owing to brain-eating amoeba. Collections E-mail
Baig AM', Khan NAZ, Order My Bibliography

=) Citati
@ Author information (=)Citation manager

Abstract Generate a file for use with external citation
In view of the devastating nature of primary amoebic meni alitis caused by ia fowleri and the prot  management software
delays and chemotherapeutic failures, here we propose a noninvasive diagnostic method using the 'reverse transcr

™ i
strategy in the management of this life-threatening infection with a case fatality rate of more than 90%. The pmprn'
interest in this emerging infection that almost always proves fatal. Create File

Copyright @ 2014 Elsevier B.V. All rights reserved.

Seasonal meningoen

KEYWORDS: Brain-eating ; Di is; Mar Naegleria fowleri; Primary amoebic meningoencephalitis; Treatment caused by Naegleria
PMID: 26445746 [PubMed - in process] Effect of thermal addi
- distribution of thern [A
1

Primary Amoebic Mei
Infant due to Naegl [C

This will create a citation file, which will most likely be found in your Downloads Folder.

(& Downloads =
E = HENERIERIEDIES Y B —
e s Downloads B
Name Date Modified Size Kind
B citations (3).nbib Today 2:45 pm 2 KB Document

Open RefWorks.
On the toolbar to the right, under the Quick Access heading, select Import.
An Import References window will open. Select the following options:
Import Filter/Datasource: NLM PubMed
Database: PubMed
Select text file: (Choose your newly downloaded citation file)

Import Into Folder: (Your desired folder)

Import References X

Quick Access g
Request a Filter List of Filters & Databases (@ Help
" From Text e 4, Advanced Search
Import Filter/Data Source | NLM PubMed +
Database | PubMed
‘ || Import
Select Text File: | Choose File | citations (3).nbib
Encoding | ANSI - Latin | [ :
Specify only if you specifically set the encoding when saving the text file; otherwise leave it as is ,u, Export
From Text
From EndNote Database E Create Bibliography
(Note that references are also put in the Last Imported folder) d;h Print References
import Into Folder  None v
( I Import P°
|
Click Import.

Using RefWorks — For Macs Page | 7
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SUMMON
When you’ve found a record in Summon that interests you, hover your cursor over the record. This will bring up additional
details to the right of the screen.

Select Cite, and then select APA as your citation format. This allows you to preview the citation.

Underneath the preview window, open the Export As... dropdown menu, and select RefWorks.

[©1 Journal Article: Full Text Online

Read Online Cite . Email

m Naegleria fowleri meningoencephalitis ®
by Cetin, Neslihan; Blackall, Douglas N Choose a Citation Format:
Blood, 04/2012, Volume 119, Issue 16 [+ O Soarch Results fonmat
[%) Journal Article: Full Text Online Cited by 1 (Scopus™) () APA (American Psychological Assoc.)

() Chicago/Turabian: Author-Date

. . . e Harvard
m Naegleria fowleri: An emerging drinking water pathogen o
by Timothy A Bartrand; Jonathan Jake Causey; Jennifer L Clancy . o .
American Water Works Association. Journal, 10/2014, Volume 106, Issue 10 [+ Sharig, A., Afridi, F. I., Faroogi, B. J.,
Ahmed, S., & Hussain, A. (2014).
Naegleria fowleri (N. fowleri) is a free-living, trophic amoeba that is nearly Fatal primary meningoencephalitis
ubiquitous in the environment and can be present in high numbers in warm waters... caused by naegleria fowleri. Journal

of the College of Physicians and

ﬁ Journal Article: Full Text Online
EEE— Surgeons--Pakistan : JCPSP, 24(7),

523-525.
m Fatal primary meningoencephalitis caused by Naegleria fowleri ®
by Sharig, Ali; Afridi, Faisal Igbal; Faroogi, Badar Jahan; more... __
Journal of the College of Physicians and Surgeons--Pakistan : JCPSP, 07/2014, Volume 24, [+ Export As... » Print Email
Issue 7
Hafwi_ﬂ(f/-
Naegleria fowleri is a free living parasite which habitats in fresh water reservoirs... EndNote
[7 Journal Article: Full Text Online BibTeX
Citavi

GOOGLE SCHOLAR
The process of importing citations from Google Scholar is fairly similar to the Summon process.

Under your chosen citation, click Cite. This will bring up a Cite window with three different citation formats. Select APA,
then click RefWorks.

Cite

Copy and paste a formatted citation or use one of the links to import into a bibliography
manager.

MLA  De Jonckheere, J., P. Van Dijck, and H. Van de Voorde. "The effect of thermal
pollution on the distribution of Naegleria fowleri." Journal of hygiene 75.01
(1975): 7-13.

ermal pollution on the distribution of Naegleria fowleri. Journal of hygiene,
75(01), 7-13.

Fe Jonckheere, J., Van Dijck, P., & Van de Voorde, H. (1975). The effect of

De Jonckheere, J., P. Van Dijck, and H. Van de Voorde. "The effect of thermal
pollution on the distribution of Naegleria fowleri." Journal of hygiene 75, no. 01
(1975): 7-13.

BibTeX EndNote RefMan( RefWorks ™
I

Using RefWorks — For Macs Page | 8
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USING WRITE-N-CITE

Once you've installed Write-N-Cite, and loaded the Write-N-Cite toolbar, then you’re ready to begin.

Have your Refworks tab open and navigate to the Tools menu at the top of the screen (much like you did when you were
first installing RefWorks). In the newly opened window, copy the Write-N-Cite Login code:

How do | log into Write-N-Cite 4 using my institution Write-N-Cite
credentials? -
. RefGrab-It

If you use your institution's credentials (Athens, Shibboleth or Proxy) !

to log in to RefWorks, you MUST copy and use this code on the Write- 'f";Backup & Restore
N-Cite 4 login screen:

455c77465072475d605f54614d1433392221280605202c252c23
11113c242b14001e243f2b0al5182f212557182e212a2b0f14113

32b330d1e30516d
b7

Navigate back to your Word document and select the Login icon on the toolbar and paste in the Login code you just
copied:

[o = | oa — 7a)

Flow |
Username:
Password:

Login code: 12b0f1411332b330d1e30516d

You can find your code on the Write-N-Cite
download page within RefWorks.

Cancel m

Congratulations! Your RefWorks data will now sync with Word and the other toolbar options are now ready to be used!

or

If you add or change any references after you've logged onto Word, you need to sync your database to Word by pressing

the Sync button (circled below).

Before we begin inserting references into the text, you must first select the correct citation style. This is done by selecting
the arrow in the Style dropdown.

| " | l--l = Harvard - Briti. & = e — Select Output Style
_~ Harvard - British Standard_ Filter: | Available styles :

Note: More styles are available in RefWorks via the Output Style Manager.
Harvard UNDA

AGLC 3rd - Australian Guide to Legal Citation, 3rd Edition (Notes & Bibli...
MLA 7th Edition

Chicago 16th Edition (Author-Date System)

Uniform - Uniform Requirements for Manuscripts Submitted to Biomedi...
AMA - American Medical Association, 10th Edition

APA 6th - American Psychological Association, 6th Edition

| Cancel | ( Save 3

Using RefWorks — For Macs Page | 9
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To insert a new citation, click in your document when you’d like it to be inserted then select the icon on the furthest left on

the toolbar.

Brain eating amoebae are bad |

(=N

Insert/Edit Citation

Q Search references

FolderView Reference View

Select Reference:

» ] Documents

» [ Examples

» (1 Last Imported

Adit, 2014, "Dermatillomania: In patient undergoing orthodontic treatment”
Alexeieff,A., 2011, "Naegleria fowleri”

Alexeieff,A., 2011, "Naegleria fowleri"

Blair,B., 2008, "Naeg

Edit Reference:

| Hide year Suppress pages | Make footnote
| Hide author Override pages _| Bibliography only
Prefix: Suffix:

Preview Citation (APA 6th - American Psychological Association, 6th Edition):
(Blair, Sarkar, Bright, Marciano-Cabral, & Gerba, 2008)

Compose Citation:

Blair,B., 2008, "Naegleria fowleri in well water”

‘4|DHI ‘+|

| Override default ordering

ot (T s

The Insert/Edit Citation window has two views, depending on how
you organise your citations in RefWorks, it's generally best to be in
Folder View.

Select the citation you’d like to insert.
Click Save.

Congratulations, you've just inserted your first citation!

Brain eating amoebae are bad (Blair, Sarkar, Bright, Marciano-Cabral, &
Gerba, 2008).

Q Search references

Depending on the type of reference you'’re inserting, you can edit [T Reference View |
how it's displayed using the options under the Edit Reference Select Reference:
heading. » (| Last Imported

Use the Hide Author feature for narrative in-text references:

Adit, 2014, "Dermatillomania: In patient undergoing orthodontic treatment”
Alexeieff,A., 2011, "Naegleria fowleri"

Alexeieff,A., 2011, "Naegleria fowleri"

Blair,B., 2008, "Naegleria fowleri in well water"

. . . Cetin,Neslihan, 2012, "Naegleria fowleri i halitis"
Blair et al. (2008) suggested that brain eating amoebae are bad. o ML 3t e W

Use the Suffix field for citing the page number when including a

direct quotation:

“Bad brain eating amoebae are bad” (Blair et al. 2008, p.223)

Linam,W.M., 2015, "Successful Treatment of an Adolescent With Naegler...

Edit Reference:
% Suppress pages || Make footnote
¥ Hide author Override pages: || Bibliography only
Prefix: l l Sufﬁx:(., p.223 -

Preview Citation (APA 6th - American Psychological Association, 6th Edition):
(2008, p.223)

Compose Citation:

Blair,B., 2008, "Naegleria fowleri in well water"

aojngn

[ | Override default ordering

| Cancel | Save

Using RefWorks — For Macs
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Once you’ve completed your paper and finished inserting your references, you can generate your own reference list using
the toolbar.

Start a new page in Word at the end of your document and click on the Insert Bibliography icon circled below:

&)

References
Blair, B,, Sarkar, P, Bright, K. R., Marciano-Cabral, F., & Gerba, C. P. (2008).

Naegleria fowleri in well water. Emerging Infectious Diseases, 14(9), 1499-

1501,
Eormat Blbliography If you need to change anything about the format of your bibliography,
Preview: just click the icon to the right of Insert Bibliography and edit as
References req u | red .
Blair, B., Sarkar, P., Bright, K. R., Marciano-Cabral, F., & Gerba, C. P. (2008). Nacgleria fowleri in ) A
well water. Emerging Infectious Diseases, 14(9), 1499-1501. If you need to change any of your in-text references after having
generated your bibliography, just click your generated bibliography,
then click the Insert Bibliography icon again (which should now say
Sort by: Ordering: Remove Bibliography).
L_J Author Name (default) LE) None (default)
Appearance b EhED e Change whatever in-text references you need to change, then when
(_) Publication Title L, y .
O Publication Date ABC, . you know you’re done, just repeat the process.
( | Periodical Name la, b, ¢, ...
() Reference Type
(_JRef ID
Spacing: Margins (cm):
Indentation: Top: |0 || Bottom: 0 5
HRoiing (Caintt : Left: [0 (1] Right: [0 O

Line Spacing:
Double (default) 3

Bibliography-only citations:

# Your settings may differ from the style

Return to Defaults Cancel Save

Using RefWorks — For Macs Page | 11
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MORE INFORMATION

For tutorials, video demonstrations and step-by-step demos, see the RefWorks Lib guide, located on the University
Library home page, or at the link below:

http://refworks.libguides.com/home

FOR FURTHER ASSISTANCE

If you have any questions or would like further assistance with RefWorks, your library staff are always happy to provide.
Please see the below link for the contact details of your home library.

CONTACT Us:
http://library.nd.edu.au/home/contact

Using RefWorks — For Macs Page | 12
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